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Overview 

Stellar Extractor for Windows Backup recovers data from the corrupt windows backup files. Backup files 

can get corrupted due to the following reasons: 

 Unrecognizable file format 

 Runtime error 

 CRC (Cyclic Redundancy Check) error 

Stellar Extractor for Windows Backup uses an advanced algorithm to recover data from the corrupt 

backup files. The application is very user-friendly and does not require any prior technical skill to recover 

data from the corrupt BKF / ZIP / VHDX / FD files. 

Key features of Stellar Extractor for Windows Backup: 

 New and enhanced GUI. 

 Recovers FD files created using HP Data Protector backup utilities. 

 Recovers Microsoft Backup (BKF) files created using Windows 2003 / Windows 2000 / Windows 

XP backup utilities. 

 Recovers Microsoft Backup (ZIP) files created using Windows 8 / Windows 7 / Windows Vista 

backup utilities. 

 Recovers Microsoft Backup (VHDX) files created using Windows 10 / Windows 8.1 backup utilities. 

 Recovers BKF files created using Backup Exec by SYMANTEC Veritas software of version up to 

2016. 

 Provides a rich graphical user interface. 

 Saves a recovered file at either default location or to a location of your choice. 

 Provides search option to find a BKF / ZIP / VHDX file. 

 Allows you to preview the BKF, VHDX, FD file before saving it. 

 Supports Windows server 2012  / Windows 10 / Windows 8.1 / Windows 8 / Windows 7 / Windows 

Vista. 

  



Installation Procedure 

Before installing the software, check that your system meets the minimum system requirements: 

Minimum System Requirements: 

 Processor: Intel 

 Operating System: Windows 10 / 8.1 / 8 / 7 / Windows Vista / Windows server 2012. 

 Memory: 2 GB minimum (4 GB recommended) 

 Hard Disk: 200 MB free space 

To install the software, follow these steps: 

1. Double-click StellarExtractorforWindowsBackup.exe executable file to start the installation. 

Setup- Stellar Extractor for Windows Backup dialog box is displayed. 

2. Click Next. License Agreement dialog box is displayed. 

3. Choose I accept the agreement option. Next button will be enabled. Click Next. Select Destination 

Location dialog box is displayed. 

4. Click Browse to select the destination path where the setup files will be stored. Click Next. Select 

Start Menu Folder dialog box is displayed. 

5. Click Browse to provide a path for the program's shortcuts. Click Next. Select Additional Tasks 

dialog box is displayed. 

6. Choose the check boxes as per your choice. Click Next. Ready to Install dialog box is displayed. 

7. Review the entries. Click Back if you want to change them. Click Install to start the installation. The 

Installing window shows the installation process. 

8. After completing the process, Completing the Stellar Extractor for Windows Backup Setup 

Wizard window is displayed. Click Finish. 

Note: Clear Launch Stellar Extractor for Windows Backup check box before clicking Finish to prevent 

the software from launching.  

  



Launching the Software 

  

To launch Stellar Extractor for Windows Backup in Windows 10: 

 Click Start icon -> All apps -> Stellar Extractor for Windows Backup  -> Stellar Extractor for 

Windows Backup  Or, 

 Double click Stellar Extractor for Windows Backup icon on the desktop. Or, 

 Click Stellar Extractor for Windows Backup tile on the home screen. 

  

To launch Stellar Extractor for Windows Backup in Windows 8.1 / 8: 

 Click Stellar Extractor for Windows Backup tile on the home screen. 

Or, 

 Double click Stellar Extractor for Windows Backup icon on the desktop. 

  

To launch Stellar Extractor for Windows Backup in Windows 7 : 

 Click Start -> Programs -> Stellar Extractor for Windows Backup -> Stellar Extractor for 

Windows Backup. 

Or, 

 Double click Stellar Extractor for Windows Backup icon on the desktop. 

Or, 

 Click Stellar Extractor for Windows Backup icon for Quick Launch. 

  



User Interface 

The main user interface of Stellar Extractor for Windows Backup is as shown below: 

  

 

  

The user interface contains menus and buttons which allows you to access various features of the software. 

  



Menus 

File Menu 

 

File 

Select File 

Use this option to select the backup file. 

Save 

Use this option to save recovered 

content of the backup file. 

Scan Information 

Save Scan Info 

Use this option to save the scan 

information. 

Load Scan Info 

Use this option to load the saved scan 

information. 

  

View Menu 

 

Log Report 

Use this option to view/save the log 

report. 

  

Tools Menu 



 

Update 

Use this option to check for both, latest 

minor and latest major versions 

available online. 

  

Activation Menu 

 

Activation 

Use this option to activate the software. 

  

  

Help Menu 

 

Help 

Use this option to view the help manual 

for the software. 

Support 

Use this option to view the Support page 

of stellarinfo.com 

Knowledgebase 

Use this option to visit Knowledgebase 

articles of stellarinfo.com 

About 

Use this option to read information 

about the software. 

http://www.stellarinfo.com/support/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/


  

Buy Now 

 

Buy Online 

Use this option to Buy Stellar Extractor 

for Windows Backup software. 

  

  

  

  

http://www.stellarinfo.com/windows-backup-recovery/buy-now.php


Buttons 

 

Click this button to select the backup file which you want to recover. 

 

Click this button to search for BKF / ZIP / VHDX files. 

 

Click this button to clear the list of files found in the system. 

 

Click this button to start the recovery process. 

 

Use this option to save the log report. 

 

Use this button to stop the currently running process. 

  



Ordering the Software 

Click http://www.stellarinfo.com/windows-backup-recovery.php to know more about Stellar Extractor for 

Windows Backup. 

To purchase the software online, please visit http://www.stellarinfo.com/windows-backup-recovery/buy-

now.php. 

  

http://www.stellarinfo.com/windows-backup-recovery.php
http://www.stellarinfo.com/windows-backup-recovery/buy-now.php
http://www.stellarinfo.com/windows-backup-recovery/buy-now.php


Activating the Software 

The demo version is just for evaluation purposes and must be eventually registered to use the full 

functionality of the software. The software can be registered using the Activation Key that you receive via 

email after purchasing the software. 

To activate the software: 

1. Run the demo version of Stellar Extractor for Windows Backup software. 

2. Go to the Activation menu, click the Activation option. The Activation window is displayed as 

shown below: 

  

3. If you don't have the activation key, click the Get it now button in the window to go online and 

purchase the product. 

4. Once the order is confirmed, an Activation Key will be sent to the email provided. 

5. Type the Activation Key (received through email after purchasing the product) and click Activate 

button (Please ensure that you have an active Internet connection). 

6. The software will automatically communicate with the license server to verify the entered key. If the 

key you entered is valid, the software will be registered successfully. 

7. The 'Activation Complete' message is displayed after the process is completed successfully. Click 

OK. 

  



Updating the Software 

Stellar releases periodical software updates for Stellar Extractor for Windows Backup software. You can 

update the software to keep it up-to-date. These updates can add new functionality, feature, service, or any 

other information that can improve the software. Updates option of the application is capable of checking 

for the latest updates. This will check for both the latest minor and major versions available online. You can 

easily download the minor version through the update wizard. However, the major version, if available, has 

to be purchased. While updating the software, it’s recommended to close all the running programs. Note 

that the demo version of the software cannot be update 

To update Stellar Extractor for Windows Backup: 

 Click Update icon from Tools Menu. 

 The Update Wizard window will open. Click Next. The wizard will search for the latest updates, and 

if it finds any new updates, a window will pop up indicating its availability. 

 Click Next and the software will download the files from the update server. When the process is 

complete, the software will upgrade to the latest version. 

Live Update may not happen due to the following reasons: 

 Internet connection failure 

 Updates are not available 

 Unable to download configuration files 

 Unable to locate updated files or version 

 Unable to locate the executable file 

Note:  If a major version is available, you need to purchase the software to upgrade it. 

  



Stellar Support 

Our Technical Support professionals will give solutions for all your queries related to Stellar products. 

You can either call us or go online to our support section at http://stellarinfo.com/support/ 

For price details and to place the order, click http://www.stellarinfo.com/windows-backup-recovery/buy-

now.php 

Chat Live with an Online technician at http://www.stellarinfo.com/ 

Search in our extensive Knowledgebase at http://www.stellarinfo.com/support/kb/ 

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php 

E-mail to Stellar Support at support@stellarinfo.com 

  

http://www.stellarinfo.com/support/
http://www.stellarinfo.com/windows-backup-recovery/buy-now.php
http://www.stellarinfo.com/windows-backup-recovery/buy-now.php
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/support/enquiry.php
mailto:support@stellarinfo.com


Select File 

To select BKF / ZIP / VHDX / FD file, follow the steps given below: 

1. Run Stellar Extractor for Windows Backup. 

 

2. If you know the location of the BKF / ZIP / VHDX / FD file then click on Browse. 

3. An Open dialog box will appear. Browse and select the desired file and then click Open. 

 

4. Click Recover. 

5. In case you select VHDX files, a new dialog box appears as shown below, 



 

  

Whereas if you select  BKF / ZIP /  FD  files there is no such dialog box. 

6. Select the partition to recover. Click Recover to start the recovery process. 

7. Once the recovery process is complete a message box appears, click OK. 

 

  



Find Files 

To search BKF / ZIP / VHDX files from your computer, follow the steps given below: 

1. Run Stellar Extractor for Windows Backup. 

 

2. A Select Backup dialog will appear. If you know the location of the BKF / ZIP / VHDX / FD file then 

click on Browse and select the desired file and then click Open. 

Or, 

To search for the BKF / ZIP / VHDX files, click Search Button and select the drive/folder from 

where you want to search the files. Click Select Folder. 

3. A list of Files will appear below. A message is displayed listing the total files found. 

            

4. Select the desired file listed below which you want to recover. Click on the Recover button. 



 

Note: Using the search option only one file at a time can be recovered. 

Note:  In case of FD Files, the search option is not applicable. But if you have single FD File then you can 

select the file using Browse. If you have FD file backup folder then use the Select Folder option to select 

the FD file backup folder. 

  



Preview Files 

After scanning and recovering, Stellar Extractor for Windows Backup displays a list of files in a tree 

structure under Stellar Extractor for Windows Backup node in the left pane of the application window. 

To preview a file, click on it. The file's preview will be displayed at the bottom of the right pane of the 

application window. 

 

  

Supported File Types for Preview: 
  
Stellar Extractor for Windows Backup supports preview of the following file types: 

Acrobat files: 

PDF 

Audio Video files: 

RMI, WAV, WMV, MPG, WMV, WMA, MIDI, AU, MP3, AVI, ASF, MPEG, MID 

Image Files: 

BMP, WBMP, EMF, JPEG, JPG, PNG, MNG, GIF, TIF, TIFF, X3F, KDC, K25, ERF, DNG 

Internet files: 

HTM, HTML 

Office documents: 



DOC, DOT, DOCX, DOTX, XLS, XLT, XLB, XLSX, XLTX, PPT, PPS, POT, PPTX, RTF 

Note: Preview option is available only for BKF, VHDX and FD files, not for ZIP & BKF files of Exchange 

Server 2003, 2007, 2010 & 2013. 

  



Save and Load Scan Information 

To save scan information for BKF and FD files, follow the steps given below: 

This option allows you to recover files and save them with the "Save Scan Info" option and later load the 

.DAT file using "Load Scan Info" option. This saves time in recovering the data as we do not need to scan 

the corrupt BKF and FD file again. 

To save scan information of the corrupt BKF and FD files, follow the steps given below: 

1. To select a Backup file to recover refer to the Select File. 

2. In order to save the scan information, go to File menu and select Save Scan Info. 

3. Save dialog box will open. Browse to the folder where you want to save the scan information and 

click Save. The information will be saved in .DAT file format. 

4. A message box appears, click OK. 

 

  

To load scan information of the corrupt BKF and FD files, follow the steps given below: 

1. To load the scan information click on Load Scan Info option from the File menu. 

2. An Open dialog box will appear. From there, browse to the folder and select the desired DAT file. 

Click Open. 

3. A message box appears, click OK. 

 

Note: Scan information of only BKF and FD files can be saved and loaded. 



Save Backup Files 
 
To save the recovered contents of the BKF / ZIP / VHDX / FD file, follow the steps given 
below: 

 To save recovered files, click on Save from File menu. 

 To save only desired files, select them from the list of scanned files and then click on Save from 

File menu. 

After clicking on Save, a dialog box appears. By default, the location of the original file and the recovered 

file is the same. However, the user can also choose a different location. 

 

Note: While saving ZIP files the user can choose 'Save as compressed file' to save the files in Compressed 

format. This option is not available while saving BKF / VHDX /  FD files. 

 

  

To save the contents of the recovered backup file at default location: 

1. Select the Default Path radio button. 

2. The default path appears in the textbox. Click Save. 

3. A message box appears containing a link named "Open Containing Folder" which takes the user 

to the default location to view the saved files or you can click OK to view the files later. 



 

  

To save the contents of the recovered backup file at user-defined location: 

1. Click the User Defined Path for the user-defined option. 

2. Click the browse button and select the folder where you want to save the files and click OK. Then 

click Save. 

3. A message containing a link "Open Containing Folder" (which takes the user to the saved files 

location) appears. Click OK. 

 

  



View and Save Log 

Log window shows details of the ongoing process. After recovering and then saving the contents of the 

corrupt file, this pane shows information such as starting time and date of the recovery process, name, and 

size of selected files and end time of the recovery process. 

You can view log details in the Log Report dialog box of the application window as shown here : 

 

  

You can save log information displayed in the Log Report dialog box. 

To save log information: 

 In the View menu, select Log Report. 

 A Log Report dialog box will appear. 

 Click the Save Log button. Save As window will appear from where you have to select the 

destination path. 

 Click Save. 

           



 A message 'Log Information Saved Successfully' will display 

  



FAQs 

1. What does the demo version of the software do? 

Demo version of the software is only for evaluation and displays a preview only for the content of the 

recovered BKF / VHDX / FD file. To save the contents of the file, you need to purchase and register 

the product. 

2. Does the software make changes to my original file? 

Stellar Extractor for Windows Backup doesn't make any changes to the original file and prompts 

you to save the contents of the file as a new file. 

3. How will I know whether Stellar Extractor for Windows Backup will recover my BKF / ZIP / 

VHDX / FD files or not? 

To know whether the software will be able to recover your corrupt Backup files or not, please try the 

demo version of the software. Recover your BKF / ZIP / VHDX / FD files using Stellar Extractor for 

Windows Backup. 

4. Does the required software need to be installed on the system for previewing the recovered 

backup files? 

Yes, the required software for every scanned backup file must be installed on the system to preview 

the recovered files. 

5. Can the software recover multiple Backup Files at a time? 

The software can only recover one Backup File at a time. But in the case of FD Files, the software 

can recover multiple backup files. 

6. If the location of Backup Files is not known, can I find them using Stellar Extractor for 

Windows Backup? 

Yes, using the Search option of the software, you can find Backup Files in specific drives and 

folders of the computer. In the case of FD Files, the search option is not applicable. if you have 

single FD File then you can select the file using Browse. If you have FD file backup folder then use 

the Select Folder option to select the FD file backup folder. 

7. Does the software recover data in the same order as they are in a Backup file? 

Yes, the software recovers data in the same order as they were in the original Backup file. 

8. Can the log information of the recovered files be saved? 

Yes, the log information of the recovered backup files can be saved by using the Save Log button 

from the Log Report Dialog. 

9. What do Load Scan Info and Save Scan Info buttons do? 



To know about Load Scan Info and Save Scan Info buttons, please refer to Buttons section of the 

Help Manual. Scan Information can be loaded and saved only in case of BKF and FD files. 

10. Can I preview the Backup Files? 

The Preview option is available only for BKF, VHDX and FD files, not for ZIP & BKF files of Exchange 

Server 2003, 2007, 2010 &.2013. Please refer to Preview Files of the manual. 

  



Legal Notices 

Copyright 

Stellar Extractor for Windows Backup, accompanied user manual and documentation are copyright of 

Stellar Information Technology Private Limited, with all rights reserved. Under the copyright laws, this user 

manual cannot be reproduced in any form without the prior written permission of Stellar Information 

Technology Private Limited. No Patent Liability is assumed, however, with respect to the use of the 

information contained herein. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 
to change without notice. 
  
STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH 

REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 

EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 

ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR 

INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES 

INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS OR 

OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND THE 

MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED, BE 

LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, 

WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION 

WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE THEREOF. 

Trademarks 

Stellar Extractor for Windows Backup® is a registered trademark of Stellar Information Technology 
Private Limited. 
Windows XP®, Windows 2003®, Windows Vista®, Windows 7®, Windows 8®, Windows 10® are registered 
trademarks of Microsoft® Corporation Inc. 
All Trademarks Acknowledged. 
All other brands and product names are trademarks or registered trademarks of their respective companies. 



License Agreement - Stellar Extractor for Windows 
Backup 

Stellar Extractor for Windows Backup 

Copyright © Stellar Information Technology Private Limited. INDIA 

www.stellarinfo.com 

All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of Stellar Extractor for Windows Backup. 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 

software, unless you have a different license agreement signed by Stellar Information Technology Private 

Limited. 

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or 

use any copy of Stellar Extractor for Windows Backup with which this License is included, you may return 

the complete package unused without requesting an activation key within 30 days after purchase for a full 

refund of your payment. 

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of 

Stellar Extractor for Windows Backup. For purposes of this License, if you have a valid single-user license, 

you have the right to use a single Licensed Copy of Stellar Extractor for Windows Backup . If you or your 

organization has a valid multi-user license, then you or your organization has the right to use up to a number 

of Licensed Copies of Stellar Extractor for Windows Backup equal to the number of copies indicated in the 

documents issued by Stellar when granting the license. 

Scope of License 

Each Licensed Copy of Stellar Extractor for Windows Backup may either be used by a single person or 

used non-simultaneously by multiple people who use the software personally installed on a single 

workstation. This is not a concurrent use license. 

All rights of any kind in Stellar Extractor for Windows Backup, which are not expressly granted in this license, 

are entirely and exclusively reserved to and by Stellar Information Technology Private Limited. You shall 

not rent, lease, modify, translate, reverse engineer, decompile, disassemble or create derivative works 

based on Stellar Extractor for Windows Backup nor permit anyone else to do so. You shall not make access 

to Stellar Extractor for Windows Backup available to others in connection with a service bureau, application 

service provider or similar business nor permit anyone else to do so. 

http://www.stellarinfo.com/


Warranty Disclaimers and Liability Limitations 

Stellar Extractor for Windows Backup and all accompanying software, files, data and materials are 

distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. You 

acknowledge that good data processing procedure dictates that any program including Stellar Extractor for 

Windows Backup must be thoroughly tested with non-critical data before there is any reliance on it and you 

hereby assume the entire risk of all use of the copies of Stellar Extractor for Windows Backup covered by 

this License. This disclaimer of warranty constitutes an essential part of this License. In addition, in no event 

does Stellar authorize you or anyone else to use Stellar Extractor for Windows Backup in applications or 

systems where its failure to perform can reasonably be expected to result in a significant physical injury or 

in loss of life. Any such use is entirely at your own risk and you would not hold Stellar responsible for any 

and all claims or losses relating to such unauthorized use. 

In no event shall Stellar Information Technology Private Limited or its suppliers be liable for any special, 

incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss 

of business profits, business interruption, loss of business information, or any other pecuniary loss) arising 

out of the use of or inability to use the software product or the provision of or failure to provide support 

services, even if Stellar Information Technology Private Limited has been advised of the possibility of such 

damages. In any case, Stellar Information Technology Private Limited’s entire liability under any provision 

shall be limited to the amount actually paid by you for the software product. 

General 

This License is the complete statement of the agreement between the parties on the subject matter and 

merges and supersedes all other or prior understandings, purchase orders, agreements and arrangements. 

This License shall be governed by the laws of the State of Delhi, India. Exclusive jurisdiction and venue for 

all matters relating to this License shall be in courts and fora located in the State of Delhi, India and you 

consent to such jurisdiction and venue. There are no third party beneficiaries of any promises, obligations 

or representations made by Stellar herein. Any waiver by Stellar of any violation of this License by you shall 

not constitute nor contribute to a waiver by Stellar of any other or future violation of the same provision or 

any other provision of this License. 

  

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

  



About Stellar 

Stellar Data Recovery is a global leader in providing data recovery, data migration and data erasure 

solutions for the past two decades. Stellar Data Recovery is a customer centric, critically acclaimed, global 

data recovery, data migration & erasure solutions provider with cost effective solutions available for large 

corporates, SMEs & Home Users. Stellar Data Recovery is headquartered in New Delhi, India and has a 

strong presence across USA, Europe & Asia. 

  

Product line: 

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after accidental 

format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >> 

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS office repair 

tools. More Info >> 

Email Recovery 

A wide range of mail recovery, mail repair and mail conversion applications for Outlook, Outlook Express 

and Exchange useful in instances of data loss due to damages and corruption of Email. More Info >> 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure 

complete data protection against hard drive crash. More Info >> 

Data Erasure 

Stellar Data Erasure software under the brand BitRaser help businesses & consumers permanently erase 

confidential data beyond the scope of data recovery.  You can perform high speed bulk data erasure & 

generate erasure certificates for audit trail purpose. BitRaser supports 24 International data erasure 

standards. More Info >> 

For more information about us, please visit www.stellarinfo.com 

http://www.stellarinfo.com/disk-recovery.htm
http://www.stellarinfo.com/undelete.htm
http://www.stellarinfo.com/mail-recovery.htm
http://www.stellarinfo.com/prevent-dataloss.htm
http://www.stellarinfo.com/data-erasure/data-eraser-windows.php
http://www.stellarinfo.com/

